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1.0 The Main Program
The Battleground Ardennes Main Program is normally invoked by double clicking on a 
scenario icon.    The scenario icon executes the main program and passes to it the 
name of a subdirectory containing the scenario information.

At startup, the program looks for the following files in the scenario subdirectory:
main.map - map information
main.oob - the order of battle
main.pdt - scenario parameter data
main.org - organization information
main.ai - AI parameter data
main0.bmp - the map in low-resolution bitmap format
main1.bmp - the map in medium-resolution bitmap format
main2.bmp - the map in high-resolution bitmap format
jump1.bmp - the jump map in 2D
jump2.bmp - the jump map in 3D

The following files must exist in the main Battleground Ardennes subdirectory:
splash.bmp - Talon Soft logo
cover.bmp - cover graphics
icons1d.bmp - 1D icons
icons2d.bmp - 2D icons
icons3d.bmp - 3D icons
terrain.bmp - terrain graphics
units.bmp - unit graphics
weather.bmp - weather graphics
blankbox.bmp - unit list graphics
phasebox.bmp - next phase graphics
animat3d.bmp - 3D animations

After the main program is invoked, a battle can be loaded by using the File Menu.

The main program display has a menu bar at the top which is used to invoke most 
features of the program.    Under the menu bar is the map display.    The map display will 
have scroll bars if the map is too large to be displayed in the available area.    Under the 
map display is the Hex Information Area.    This area is used to display information about 

the status of the program and specific hexes on the map.



1.1 The Menus
These menus are associated with the Battleground Ardennes program:

The File Menu
The Phase Menu
The Units Menu
The Assault Menu
The Reinforce Menu
The Status Menu
The Display Menu
The A/I Menu
The Modem Menu
The Options Menu
The Help Menu

Command hints for each menu item are displayed in the status bar at the bottom of the 
main window when the item is selected.



1.1.1 The File Menu

The File Menu is used to start new battles and to load and save previously started 
battles.

To start a new battle, select the New menu item.    A file selection dialog will appear so 
that the starting scenario can be selected.    By convention, a starting scenario has the 
extension scn.    Scenarios are usually named for the day of the battle.

To load a previously saved battle, select the Open menu item.    A file selection dialog 
will appear so that the file name of the battle can be specified.    By convention, a battle 
file has the extension btl.

To save a battle that has been started new or loaded from a file, select the Save menu 
item.    If the battle has never been saved, a file selection dialog will appear so that the 
file name of the battle can be specified.    A battle file should be saved under a file name 
with extension btl.    Note: in general it is a good idea to save a battle periodically and 
not wait until exiting before saving the battle.    Saving the battle protects against its loss 
due to accidents such as power failures and allows for recovery in the event of a 
mistake in the use of the program.

The Save As menu item can be used to save a battle under a file name other that the 
one that currently is being used for the battle.    This allows the current state of a battle 
to be saved in another file without affecting the file being used for the battle.

The Shapshot menu item can be used to save a map of the current situation including 
the currently spotted units to a file.    A file selection dialog will appear so that the file 
name of the graphics file to be generated can be specified.    The created graphics file 
can be viewed or printed with any standard graphics application.

The Exit menu item is used to exit the program.    If the current battle has changed since 
the last time it was saved, then a dialog will appear giving the option to save the battle 

before exiting.



1.1.2 The Phase Menu

The Phase Menu is used to advance the phase.    Selecting the menu item Next causes 
the battle to advance to the next phase.    The phases are:

Prep Fire Phase
Movement Phase
Defensive Fire Phase
Offensive Fire Phase
Assault Phase
Mechanized Phase

In each turn, there are 12 such phases: 6 under the control of the Allied side and 6 
under the control of the Axis side.    The first side to move in any turn is determined by 
the parameter data associated with the scenario.    For example, if the Axis side is the 
first to move, then the 12 phases of a given turn would be:

Axis Prep Fire Phase
Axis Movement Phase
Allied Defensive Fire Phase
Axis Offensive Fire Phase
Axis Assault Phase
Axis Mechanized Phase
Allied Prep Fire Phase
Allied Movement Phase
Axis Defensive Fire Phase
Allied Offensive Fire Phase
Allied Assault Phase
Allied Mechanized Phase

At the beginning of a Prep Fire Phase for a given side, internal calculations are 
performed to determine such events as recovery from disruption and spotting.

At the end of a turn, the time is advanced by an amount that depends on parameter 
data associated with the scenario.    Typically a turn is 10 minutes long.

A scenario ends on the last phase of the turn once the time limit has been reached.    
The time limit associated with a scenario is shown after the current time in the Status 
Bar.

The Skip To End menu item is used to mark the current battle for scoring, display the 
Victory Dialog, and exit the main program.    If the current battle is being played with one 
side under A/I control and if the main program was entered via the Front End interface 
program, then selecting this menu item will cause the score for the current battle to be 

recorded in the Hall of Fame.



1.1.3 The Units Menu

The Units Menu is used to change the state of selected units and to initiate air attacks. 
Before changing the state of units, the units must be selected using the Hex Information 
Area.    Most changes to selected units can only occur during the Movement Phase by 
the controlling side and are subject to limitations as a result of the internal rules and 
movement allowances.

The To Top Of Stack menu item will move the selected units to the top of the stack.    
This can be done by the controlling side at any time.

The To Bottom of Stack menu item will move the selected units to the bottom of the 
stack.    This can be done by the controlling side at any time.

The Load/Unload menu item is used to either load units into carrier units, or to load 
units which are currently being carried.    To load units, first select both the units to be 
loaded and the units to be used as carriers.    To unload units, the carrier is selected 
from the Unit List.    After selection of the units, the Load/Unload menu item is invoked.

The Air Attack menu item is used to initiate an air attack on an enemy unit.    Air attacks 
can be initiated during the Movement Phase by the controlling side provided that side 
has air attacks available.    The number of air attacks is displayed in the alternative 
information area of the Terrain Info area.    The hex to be attacked should first be 
selected by clicking on the hex with the left mouse button.    Next the Air Attack menu 
item should be selected or a keyboard accelerator pressed.    If there are multiple 
targets in the selected hex, then a Target Dialog will be displayed.    If the initiation of the 
air attack is successful, an airplane icon will appear in the target hex.    Air attacks are 
automatically resolved at the beginning of the next Offensive Fire Phase.

The Artillery Dialog menu item is used to display the Artillery Dialog.    This dialog is 
used to select artillery units during the Prep Fire Phase.

The Undo Last Movement menu item can be used to undo the last movement.    It can 
also be used to undo the total move generated by a single Auto Movement.



1.1.4 The Assault Menu

The Assault Menu is only used during the Assault Phase by the controlling side.    To 
conduct an assault attack, a defending hex must first be selected using the right mouse 
button.    A special icon is drawn on the selected hex indicating that it is the hex being 
attacked.

Each group of units that is to attack in this assault must first be selected using the Hex 
Information Area  and then added to the assault using the Add to Assault menu item.    
Attacking units must be adjacent to the defending hex and satisfy all other internal rules 
for assaults.

After all attacking units have been selected, the assault can be resolved by selecting the 
Resolve Assault menu item.    This will resolve the assault according to the internal rules 
and a dialog will be displayed showing the results of the assault.    If the defending units 
are eliminated, the attacking units will automatically occupy the defending hex.

The Show Odds menu item can be used to review the odds associated with the current 
assault.



1.1.5 The Reinforce Menu

The Reinforce Menu can be used to determine what reinforcements are scheduled to 
appear in the current scenario and to determine what reinforcements have arrived and 
are available to be placed on the map.

The Scheduled menu item displays the Schedule Dialog.    This dialog is used to display 
the reinforcements that are scheduled to arrive during the current scenario.

The Arrived menu item displays the Arrived Dialog.    This dialog is used to display the 
reinforcements that have arrived and are available to be placed on the map.



1.1.6 The Status Menu

The Status Menu can be used at any time to display information about the current 
status of the battle including strength, objective, and victory information.    Selecting the 

Strength menu item causes the Strength Dialog to be displayed.    Selecting the 
Objectives menu item causes the Objectives Dialog to be displayed.    Finally, selecting 

the Victory menu item causes the Victory Dialog to be displayed.



1.1.7 The Display Menu

The Display Menu is used to control how information is displayed on the map.

The Units Off menu item toggles the display of units on the map.    When this item is 
checked, the position of units on the map is indicated with a hollow outline.    This option 
is used to be able to view the underlying map terrain better.

The Unit Bases Off menu item toggles the display of bases under units in the 3D 
graphics.    When this item is checked, units are drawn on the 3D map without their oval 
base.

The Specials On Top menu item is used to control the display of special counters such 
as forts and mine fields on the map.    When this item is checked, special counters will 
be displayed on top of the stack of units.    When this item is unchecked, special 
counters will be displayed on the bottom of a stack.

The Objectives menu item is used to control the display of objective hexes on the map. 
Objective hexes are scenario-specific hexes with assigned values that are used to 
determine victory and defeat in a given scenario.    When this item is checked, objective 
hexes will be displayed with a special icon.    Objective values are also displayed in the 
Terrain Info area of the main program.

The Locations menu item is used to display the Locations Dialog.    This dialog can be 
used to find specific locations on the map.    Locations can also be displayed on the map 
itself by pressing and holding either Shift key.

The Hex Outlines menu item is used to control the display of the hex outlines on the 
map.    When this item is checked, hex outlines will be shown on the map.

The Find Org menu item is used to display the Organization Dialog.    This dialog is used 
to display specific organizations on the map.

When the Spotted Units menu item is checked, all enemy units on the map that are 
currently spotted will be displayed with a highlighted border.

When the Fired/Fought Units menu item is checked, all units on the map that have 
either fired at an enemy unit or fought in an assault during the current phase will be 
displayed with a highlighted border.

When the Moved Units menu item is checked, all units on the map that have moved 
during the current phase will be displayed with a highlighted border.

When the Disrupted Units menu item is checked, all units on the map that are disrupted 
will be displayed with a highlighted border.

When the Indirect Fire Units menu item is checked, all units capable of firing using 
indirect fire will be displayed with a highlighted border.

When the Organization menu item is selected, all units in the same organization as the 
first selected unit in the current stack will be displayed with a highlighted border.

The Spotted, Fired/Fought, Moved, Disrupted, Indirect Fire Units, and Organization 
menu options are mutually exclusive so that selecting one of these will clear any of the 
others that have been previously selected.    During the Assault Phase, if no other 



highlight options have been selected, then units which are Attacking will be highlighted.

The Zoom Out menu item is used to change the display resolution of the map.    When 
the map is "Zoomed Out", a low resolution map is displayed that allows more of the map 
to be shown on the screen.

The Normal View menu item restores the map resolution to the original setting.

The Zoom In menu item is used to change the display resolution of the map.    When the 
map is "Zoomed In", a high resolution map in isometric perspective is displayed that 
shows more detail on the screen.    In this view, units are shown as physical entities and 
have a facing associated with them.    This facing is only used for display purposes and 
has no impact on combat or movement.    The facing of a unit is automatically changed 
as a result of movement.    It may also be changed manually using keyboard 
Accelerators.

When the map is zoomed in and out, the map is scrolled to display the current Hot Spot 
near the middle of the map.

The Rotate Tool Box menu item causes the orientation of the Tool Box to be toggled 
between vertical and horizontal.



1.1.8 The A/I Menu

The A/I Menu is used to invoke the "Artificial Intelligence" capabilities of the program.    
When A/I is in effect, some or all of the decisions for a particular side will be made by 
the software and the software will automatically carry out the appropriate actions such 
as firing and moving.    The A/I feature can be used in three modes: Manual, 
Semiautomatic, and Automatic.    Each mode can be applied independently to each side: 
Allied and Axis.

In Manual A/I mode, the user makes all decisions for a particular side and is responsible 
for making all moves and firings for that side.    This is the default mode.

In Semiautomatic A/I mode, the user will be prompted to make certain high-level 
decisions for that side, but the software will automatically take care of all low-level 
actions such as moving and firing.    In this mode, the user plays the part of the overall 
commander of that side, but does not have to get involved with the details of carrying 
out the orders.

In Automatic A/I mode, the software takes care of all decisions and actions for that 
particular side.    This mode is appropriate when the user wants to take one side and 
have the software play the role of the other side.

An additional option that can be applied to Automatic A/I mode is Fog-of-War.    In this 
mode, only the units that can currently be spotted for that side will be displayed on the 
map.    If units hidden by Fog-of-War are encountered during a move phase, then they 
are displayed using question mark graphics.    These units will be displayed in full detail 
at the beginning of the next phase.

The current A/I mode for a scenario is saved and restored from the battle file.    The 
Activate A/I menu item is used after A/I processing has been interrupted to restart the 
A/I from the point it was canceled.    Even when a phase is not under the control of A/I, 
A/I processing can be activated through the remainder of the phase using the Activate 
A/I menu item.

The Order Dialog menu item is used to display the Order Dialog.    This dialog is used to 
specify orders for a side in Semiautomatic A/I mode.

The message "A/I Control" will be appended to the phase description in the Status Bar 
when that phase is under the control of A/I processing.



1.1.9 The Modem Menu

The Modem Menu is used to establish and manage a modem connection with another 
computer for modem play.    In modem play, one computer will be the "host" and the 
other computer will be the "caller".    The host is responsible to starting new battles and 
reading and writing existing battles.    The user on the caller system is responsible for 
supplying an encryption key which is used to encrypt the battle file on the host system. 
Battles which are currently being played under modem play are saved with the 
extension ".btx" and have a different format than ordinary battle files.    Battles being 
played over a modem may be played either with Fog-Of-War on or off.    This option is 
decided at the beginning of the battle by the user on the host system.    The 
Commnications Dialog supports a "chat" capability which allows the two users engaged 
in modem play to communicate with each other.

While using modem play, each computer system will either be under Local Control or 
Remote Control in each phase.    While under Local Control, the user can perform 
actions normally and these actions will be communicated to the remote system.    While 
under Remote Control, a user is prevented from making changes to the battle and is 
dependent on the remote system for the actions that take place.    The current status of 
Local or Remote Control is listed as part of the phase description in the Status Bar.

The Host menu item is used to establish a computer system as the host for modem 
play.    After establishing communications parameters, the host system is put into a state 
where it will accept outside calls from the caller system.

The Caller menu item is used to establish a computer system as the caller for modem 
play.    After establishing communications parameters, the user on the caller system then 
specifies a phone number to dial and an encryption key to use to encrypt and decrypt 
battle files.

The New Encryption Key menu item is used by the user on the caller system to 
establish a new encryption key.    This new key will be used for all subsequent reads and 
writes of battle files by the host system.

The Resync with Remote menu item is used whenever communication problems 
between the host and caller cause the current battles being played on the two systems 
to get out of sync with each other.    Either side in modem play can initiate a resync 
using this menu item. It should only be used when the users decide that the current 
battle has    become out of sync.

The Communication Dialog menu item is used to reestablish the Communications 
Dialog after it has been closed by the user.    The Communications Dialog is 

automatically opened once modem play has been established and will be automatically 
opened whenever there is "chat" communication from the remote system or if 

communication lags cause the number of messages waiting to be sent to the remote 
system to reach 20.



1.1.10 The Options Menu

The Options Menu is used to control certain options associated with the main program. 
The setting of these options is saved in the initialization file bga.ini located in the 
Windows directory.    Changes to these options will carry over to subsequent executions 
of the main program.

The Introduction menu item controls the playing of the introductory material at the 
beginning of the main program.

The Beep on Error menu item toggles the option that causes the program to beep when 
the user makes an error.

The Blink Hot Spot menu item toggles the option that causes the Hot Spot indicator to 
blink on the map.

The Smooth Scroll menu item toggles the option that causes the map to be scrolled 
smoothly when a new Hot Spot is displayed by the main program.    When this option is 
disabled, the map will be redrawn directly at the new Hot Spot location without scrolling 
through the intermediate hexes.

The Sound Effects menu item toggles the playing of sound effects associated with 
various actions of the main program.

The Video Effects menu item toggles the playing of video effects associated with 
various actions of the main program.

The Graphical Unit Icons menu item toggles the display of unit icons between graphical 
and schematic versions.

The Graphical Unit List menu item toggles the unit list display between graphical and 
standard list versions.

The 3D Dialogs menu item toggles the appearence of the main program dialogs 
between the enhanced 3D appearence and the standard Windows dialog appearence.

The Dialog Help Buttons menu item toggles the appearence of Help buttons in the 
dialogs used by the main program.

The Auto Save menu item toggles the auto-save option.    When the auto-save option is 
in effect, the current battle is automatically saved before the phase is advanced except 

for phases under A/I control.



1.1.11 The Help Menu

The Help Menu is used to get information about how to use the Battleground Ardennes 
program, about the battle being fought, and about the program itself.    The General 

Help menu item invokes the Windows help program using the Battleground Ardennes 
general help file.    The Unit Handbook menu item invokes the Windows help program 
using the Battleground Ardennes unit handbook file.    The Parameter Data menu item 
invokes the Windows help program using a help file with information about parameter 

data specific to the current battle.    The About Battleground Ardennes menu item 
displays a dialog with certain information about the Battleground Ardennes program 

including version and copyright information.



1.2 The Dialogs
These dialogs are associated with the Battleground Ardennes program:

The Target Dialog
The A/I Action Dialog
The Order Dialog
The Strength Dialog
The Objectives Dialog
The Victory Dialog
The Locations Dialog
The A/I Selection Dialog
The Artillery Dialog
The Organization Dialog
The Schedule Dialog
The Arrived Dialog
The Jump Window
The Modem Settings Dialog
The Communications Dialog
The Dial Dialog

The New Modem Scenario Dialog



1.2.1 The Target Dialog

The Target Dialog is displayed whenever a hex is fired upon that contains more than 
one different target unit.

The Target Dialog displays the list of possible target units.    An entry from the list should 
be selected by clicking on it with the left mouse button and the OK button pressed.    
Alternatively, when the buttons are not displayed, a target can be selected by double-
clicking on the entry with the left mouse button.

A unit which appears in the Target Dialog as a grayed entry is one that cannot be fired 
upon by all firing units due to range limitations.

If the Cancel button is clicked on or the Escape key pressed, then no firing will occur.



1.2.2 The A/I Action Dialog

The A/I Action Dialog is used to display the results of A/I processing.    By default, the 
dialog will appear in the lower right corner of the screen and the map will be scrolled to 
bring the corresponding portion of the map to the center of the display.    The Dialog will 
reappear in its previous position each time it is displayed.

The A/I Action dialog has Step, Run, and Cancel buttons.    The Step button is normally 
the default and will be outlined in black.    The user has the option of clicking on any 
button with the mouse, or invoking the default button by hitting return.    If the user 

invokes the Step button, then A/I processing will continue until the next A/I step.    If the 
user invokes the Run button, then A/I processing will continue until there are no more 

A/I actions for that phase.    Clicking on the Run button a second time while the A/I 
Action dialog is displayed turns this option off.    The user can select the Cancel button 

to halt the A/I processing before it terminates for that phase.    Alternatively, the user can 
press the Escape key to cancel the A/I dialog while it is visible on the screen.    If the A/I 
dialog is terminated, then the Activate A/I menu item from the A/I Menu should later be 

selected to resume the A/I processing at the point it was canceled.



1.2.3 The Order Dialog

The Order Dialog allows the user to specify the order for a turn when a particular side is 
in Semiautomatic A/I Mode.    The Order Dialog lists the organizations of the current 
side.    As an organization is selected, information about the organization and any order 
currently given to the organization are displayed.    The information displayed about an 
organization includes the size of the organization in units, the percentage of those units 
that are currently undisrupted, and the center location of the organization.    The center 
location of the organization is calculated as the average of the positions of the units in 
the organization.    Reinforcements that have not arrived have their entry hex as their 
location for this calculation.

Orders can be given to the selected organization using the Order Dialog and the map.    
The type of order is first selected from the list shown. Once the type of order is selected, 
the objective hex is selected by    clicking on the map hex with the right mouse button.

The Order Dialog is redisplayed at the beginning of each player turn. Existing orders 
can be left unchanged by clicking on the OK button.    Clicking on the Cancel button 

cancels the A/I processing at that point.    The A/I processing can be resumed by using 
the A/I menu or clicking on the A/I button in the toolbox.



1.2.4 The Strength Dialog

The Strength Dialog displays the number of units on the map and the losses associated 
with each side during the current battle.    If there is a single number associated with a 

unit type in the strengths listing, then that number indicates the total number of units on 
the map of that type.    If there is a second number in parentheses in the strengths 

listing, then that indicates the total number of disrupted units of that type on the map. 
The number in square brackets is the number of Victory Points associated with the unit. 
This dialog is simply an informational dialog to give some information about the status of 

the current battle.



1.2.5 The Objectives Dialog

The Objectives Dialog displays a list of objectives, their value, and which side is 
currently in possession of the objective.    Clicking on an entry in the list causes the map 

to scroll to the objective hex location and for that hex to be made the Hot Spot.    If an 
objective hex is not currently occupied, then possession of the hex is based on which 

side last occupied the hex.



1.2.6 The Victory Dialog

The Victory Dialog displays the current state of the victory conditions.    The number of 
units lost by each side and the value of each unit is displayed as well as total loss for 
that side.    Depending on which side is the first side for that scenario, the objective 
points held by that side is displayed and the total of objective points adjusted by the 
total unit losses is also displayed.    The range of values used to determine victory is 

displayed and the resulting outcome at that point.



1.2.7 The Locations Dialog

The Locations Dialog displays a list of the map labels and can be used to find specific 
locations on the map.    Each map label in the list is followed by its hex coordinates. 

Clicking on an entry in the list causes the map to scroll to the hex location and for that 
hex to be made the Hot Spot.



1.2.8 The A/I Selection Dialog

The A/I Selection Dialog allows the A/I setting of a scenario to be set at the beginning of 
the scenario.    For more information on the A/I settings, see the A/I Menu.



1.2.9 The Artillery Dialog

The Artillery Dialog allows artillery to be selected and fired during the Prep Fire Phase. 
To fire a unit which is displayed in the Artillery Dialog, first select the unit using the left 
mouse button, and then click on the target hex with the right mouse button.    When a 
unit in the Artillery Dialog is selected, the potential targets of that unit are highlighted on 
the map.

Depending on the scenario, there may be units which are defined to be off-board 
artillery.    These units have a location which is not within the boundaries of the map. 

Off-board artillery units are designated in the Artillery Dialog with an asterisk (*) 
preceeding their name.    Using the Artillery Dialog is the only way to fire using off-board 

artillery units.



1.2.10 The Organization Dialog

The Organization Dialog allows the various organizations associated with the units on 
the map to be displayed.    When the Organization Dialog is displayed, it shows a list of 
all the organizations.    Selecting an organization from the list causes all of the units 
associated with that organization to be highlighted.

Clicking on OK causes the selected organization to continue to be highlighted, while 
clicking on Cancel cancels the display of the organization.    Alternatively, double clicking 
on an organization entry causes the organization to continue to be highlighted after the 

dialog is closed.



1.2.11 The Schedule Dialog

The Schedule Dialog is used to display reinforcements which are scheduled to arrive in 
the current scenario.    Selecting an item in the list of reinforcements automatically 

scrolls the map to the arrival location of the reinforcement and makes the location the 
current hot spot.



1.2.12 The Arrived Dialog

The Arrived Dialog is used to display reinforcements which have arrived and are 
available to be placed on the map.

Reinforcements may only be placed on the map during the Movement Phase. There are 
two ways to place units listed in the Arrived Dialog on the    map.    First, units to be 

placed on the map may be double clicked on.    Second, units to be place on the map 
may be selected with a single click followed by clicking on the OK button on the Arrived 
Dialog.    Both of these cause the unit and any associated carrier or passenger unit to be 
placed on the map if possible and the map scrolled to the arrival location.    Placement 

of reinforcements is prevented if placement of the units would cause overstacking in the 
arrival hex.    If enemy units occupy the placement hex, they are automatically overrun 

by the placement of the reinforcements.    If placement of the reinforcements would 
cause overstacking, then the Arrived Dialog can be dismissed, the units in the arrival 

hex moved, and the Arrived Dialog redisplayed.



1.2.13 The Jump Window

The Jump Window allows the user to easy go from one part of the map to another.    The 
Jump Window displays a reduced version of the map with the current portion of the map 

visible on the screen drawn in a rectangle and the hot spot identified with a small 
square.    Clicking on a location of the Jump Window with the left mouse button causes 
the map to be repositioned so that the selected hex is the new hot spot and is centered 
as much as possible in the middle of the screen.    Hitting return causes the map to be 
repositioned so that the hot spot is centered as much as possible in the middle of the 

screen.



1.2.14 The Modem Settings Dialog

The Modem Settings Dialog is used to configure the modem before starting modem 
play.    The values set in this dialog are saved in the Battleground Ardennes initialization 
file bga.ini and restored in subsequent executions of the main program.

The Initialization string is sent to the modem before any other commands.    This 
command resets the modem back to its initial state.    The default value of this string is 
ATZ.

The Dial Prefix string is sent to the modem just prior to dialing the remote phone 
number.    The default value of this string is ATDT.

The Dial Suffix string is sent to the modem just after dialing the remote phone number.    
The default value of this string is empty.

The Escape string is sent to the modem to cause it to go off-hook just prior to hanging 
up.    The default value of this string is +++.

The Hangup string is sent to the modem to cause it to hangup the phone and to put it in 
a state where it will not auto-answer.    The default value of this string is ATHS0=0.

The Auto Answer string is sent to the modem to put it in a state where it auto-answer 
any incoming call.    The default value of this string is ATS0=1.

The Baud Rate setting in this dialog establishes the baud rate of the communication 
between the computer and the modem.    This setting should correspond to the highest 
speed supported by the modem.    For modems which support 28.8Kb, the baud rate 
should be set at 38400.

The Port setting in this dialog should correspond to the port that the modem is 
connected to.

The Timeout setting determines how long the communication code will wait after issuing 
a modem command for a reply from the modem.    The default timeout value is 30 

seconds.



1.2.15 The Communications Dialog

The Communications Dialog is used to provide communication information to the user 
during modem play and to support "chat" communication.    There are two main windows 
in the Communications Dialog.    One of them can be used by the user to type chat 
communication for transmission to the other system.    The Remote window is used to 
display chat communication typed by the remote user.

The Queue window is used to display the number of events waiting to be communicated 
to the other side.    If this number is 0, then both sides are in sync.    The Status window 
displays a message indicating the current status of communications between the two 

systems.



1.2.16 The Dial Dialog

The Dial Dialog is used by the client system in modem play to dial the server system 
and to specify the encryption key to be used when reading and writting modem battle 

files on the server system.    The encryption key choosen by the user on the client 
system should be kept secret to prevent other users from reading the modem battle file 

on the server system.



1.2.17 The New Modem Scenario Dialog

The New Modem Scenario Dialog is used at the beginning of a scenario that is going to 
be played using the modem to define which sides each user will be playing and whether 
Fog-of-War will be in effect for the battle.    If Fog-of-War is assigned at the beginning of 

the battle, it cannot be disabled during the battle.



1.3 The Hex Information Area
The Hex Information Area is displayed below the map.    The Hex Information Area is 
used to display information about the current state of the program and information 
regarding the current "Hot Spot".    A hex is selected to be the Hot Spot by clicking in the 
hex with the left mouse button.    The Hot Spot hex is indicated on the map with a red 
outline.    The Hex Information Area contains three parts:

The Terrain Info Field
The Unit List

The Status Bar



1.3.1 The Terrain Info Area

The Terrain Info area displays information about the terrain in the Hot Spot hex.    The 
Terrain Info area appears in the lower left hand corner of the main screen.    A picture of 
representative terrain of the Ardennes is shown in the upper half of the Terrain Info area.

The terrain type in the Hot Spot hex and the combat modification associated with this 
terrain type are displayed on the first text line of the info area.    The elevation of the hex 
in meters is displayed on the next line.    Icons displaying special features of the terrain 
are shown on the last line.    These include objective values, mines, improved positions, 
and smoke counters.

Clicking either the left or right mouse button in the Terrain Info area displays alternative 
information.    The first line of alternative information is the number of air points assigned 
to the current scenario.    This information is shown as two numbers separated by a 
slash. The first number is the number of air attacks available to the Allied side.    The 
second number is the number of air points available to the Axis side.    If a particular side 
is under Fog-of-War, then its number is replaced with a question mark.

The second line of alternative information is the number of smoke attacks available to 
each side in the current scenario.    As for air points, this is show as a pair of numbers 

with the Allied value first and the Axis value second.



1.3.2 The Unit List

The Unit List displays the units in the Hot Spot.    There can be a total of four units and 
wrecks in any location on the map.    When the Hot Spot location on the map is empty, 
then the Unit List displays a panoramic view of the weather conditions associated with 
the current scenario, plus a description of these conditions including the maximum 
visibility.

Each unit in the Unit List has several fields that are used to display the capabilities of 
the unit.    The field labeled Ak displays the hard and soft attack values of the unit.    The 
hard attack value is used when firing on armoved units.    The soft attack value is used 
when firing on unarmored units.

The field labeled Rg displays the hard and soft range values of the unit.    The hard 
range value is the maximum range of the unit when firing at armored units.    The soft 
range value is the maximum range of the unit when firing at unarmored units.

The field labeled Aslt displays the assault value of the unit.    This value is used when 
the unit conducts an assault attack.

The field labeled Mov displays the remaining movement value of the unit.    During a 
movement phase, this value will decrease as the unit is moved.    Once this value 
reaches zero, the unit is no longer capable of moving that phase.

The field labeled Def displays the defensive value of the unit.    This value is used to 
determine the outcome when the unit is fired upon.

The field labeled VP displays the victory points assigned to the unit.    These points 
establish how many victory points are awarded the other side for eliminating this unit.

The field labeled Mr displays the current morale of the unit.    Morale values in general 
range from 1 to 9.    The current morale value of a unit is affected by combat results and 
determines how easily the unit will retreat under fire.

There are a number of icons associated with each unit in the Unit List.    A full-color 
bullet icon indicates that the unit can fire or assault in the current phase.    A brown bullet 
icon indicates that the unit has already fired in the current phase.

A full-color wheel icon indicates that the unit can move in the current phase.    A brown 
wheel icon indicates that the unit has started moving in the current phase or is 
incapable of moving because it has previously fired.    The absence of a wheel icon 
indicates that the unit cannot move in the current phase.

A full-color helmet icon for vehicles indicates that the vehicle is currently carrying a 
passenger.    A brown helmet icon for vehicles indicates that the vehicle is currently 
empty.    A brown helmet icon for other units indicates that the unit can be carried as a 
passenger.

A full-color binoculars icon indicates that the unit is currently spotted by enemy units.    A 
brown binoculars icon indicates that the unit is currently spotted by an enemy unit that 
cannot fire on it such as a truck or wagon.

When a vehicle is carrying a unit, only the vehicle is shown in the Unit List.    To see the 



passengers being carried by vehicles in the Unit List, click on the Unit List with the right 
mouse button, or click in the Terrain Info area with the left mouse button.    The 

passenger units will be displayed until the mouse button is released.



1.3.3 The Status Bar

The Status Bar display informational messages about the current status of the program 
and error messages.    The Status Bar is shown at the bottom of the main program 
screen.    By default, the Status Bar shows the current phase of the scenario.    The 
elapsed time and time limit associated with the current scenario are shown with the 
current phase.    If the current phase is being performed using A/I, then the words "A/I 
Control" will follow the description of the current phase.

While playing using Modem Play, the status bar will either show the words "Local 
Control" or "Remote Control".    While under Local Control, the user has the ability to 
move and fire units normally.    While under Remote Control, the user is waiting for the 
remote user to complete the current phase.

At the right end of the status bar, the map coordinates of the Hot Spot hex are shown.



1.4 Other Features
Other features associated with the main program are:

Using The Mouse
Accelerators
Auto Movement
Auto Target
Drag and Drop
The Tool Box

Auto Scrolling



1.4.1 Using The Mouse

The mouse is used to get information on the units and terrain on the map and to control 
the actions of units on the map.

Single-click with Left Mouse Button: This will display information on the units and terrain 
in the designated hex.    This action can be performed on any hex during any phase.

Double-click with Left Mouse Button: In addition to displaying information on the units 
and terrain in the designated hex, this action also selects all units in the Unit List.    This 
is commonly done before moving units, having them fire, or using them in an assault.

Single-click with Right Mouse Button: The result of this action is dependent on the 
current phase.

1. During the Movement Phase, this action causes the units selected in the Unit 
List to be moved to the designated hex

2. During a Fire Phase, this action causes the units selected in the Unit List to fire 
on the designated hex.    If the fire is direct and there is more than one potential 
target in the target hex, a Target Dialog will be displayed that allows for the 
selection of the target.    If the Ctrl key is held down while the Right Mouse Button 
is clicked, then this causes smoke to be fired into the hex.    Only certain indirect 
fire units are capable of firing smoke and the ability to fire smoke is dependent on 
available smoke ammunition.

3. During an Assault Phase, this action causes the selected hex to be designated 
as the defending hex.    After this has been done, adjacent units can be 
designated as attacking units using the Left Mouse Button, selecting from the 
Unit List, and adding them to the attack using the Assault Menu.

If the Right Mouse Button is clicked in the current Hot Spot during a movement phase, 
then the counters in that hex will be cycled with the top counter moving to the bottom of 

the stack.



1.4.2 Accelerators

The main program supports the use of the following accelerators:
Ctrl-N - advance to next phase
Ctrl-U - undo last movement
Keypad 0 - load/unload selected units
Keypad 1 - move selected units down and left
Keypad 2 - move selected units down
Keypad 3 - move selected units down and right
Keypad 5 - initiate air attack on hot spot hex
Keypad 7 - move selected units up and left
Keypad 8 - move selected units up
Keypad 9 - move selected units up and right
Left Arrow - scroll map to the left
Right Arrow - scroll map to the right
Up Arrow - scroll map up
Down Arrow - scroll map down
Shift - display location names on the map
F1 - open general help file
F2 - open unit handbook
F3 - display parameter data

The following accelerators only affect the appearence of the unit icons while in Zoom In 
mode and have no effect on the scenario.

Delete or Ctrl-L - turn selected unit icons counter-clockwise
Page Down or Ctrl-R - turn selected unit icons clockwise
Home or Ctrl-F - move selected unit icons forward

End or Ctrl-B - move selected unit icons backward



1.4.3 Auto Movement

Auto Movement is used to automatically move units from one location to another on the 
map without having to specify all of the intermediate hexes.    To use Auto Movement, 
you first select the units to be moved in the normal way using the first mouse button and 
making selections in the Unit List.    You then click on the destination hex using the right 
mouse button while holding down the Alt key.    This causes the program to determine a 
minimum-distance path towards the destination hex and then to move the selected units 
along that path up to the limits of the movement allowance.    You can use the Undo 
feature of the Units Menu to undo the total movement generated by a use of Auto 
Movement.    Note however, that the Undo feature is disabled when Fog-of-War or 
Modem Play are in effect.

The normal Auto Movement minimum-path algorithm will only search for direct paths 
from the source to the destination hexes.    This is to avoid inadvertantly causing units to 
move away from the destination hex due to obstructions such as rivers.    Holding down 

the Ctrl control key in addition to holding down the Alt key causes Auto Movement to 
use an extended minimum-path algorithm that will search for detours if a direct path is 

not available.



1.4.4 Auto Target

Auto Target can be used to facilitate firing on or assaulting a specific hex.    The Auto 
Target feature is invoked by clicking on the target hex with the right mouse button while 
holding down the Alt key.    If the current phase is a fire phase, then a suitable firing unit 

will be automatically selected to fire on the target hex.    If the current phase is the 
Assault Phase, then attacking units will be automatically selected to assault the target 
hex.    In either case, a dialog with the resulting action will be displayed for confirmation 

before the action is carried out.



1.4.5 Drag and Drop

Drag and Drop can be used to facilitate moving, firing, and assaulting in place of the 
standard use of the right mouse button.    To use Drag and Drop, units must first be 

selected.    This can be done by either clicking on a hex with the left mouse button and 
making the selection from the Unit List or by double clicking on a hex and thus selecting 
all units in the hex.    In either case, Drag and Drop is initiated by holding down the left 

mouse button in the hex after the selection has been made.    The mouse is then moved 
to the destination hex while holding the left mouse button down.    Drag and Drop is 

activated by releasing the left mouse button in the destination hex.    The effect of Drag 
and Drop depends on the current phase.    If the current phase is the Movement Phase, 
then Drag and Drop causes an Auto Move of the selected units toward the destination 

hex.    If the current phase is a fire phase, then Drag and Drop causes the selected units 
to fire on the destination hex.    If the current phase is the Assault Phase, then Drag and 

Drop initiates and resolves an Assault against the destination hex using all valid 
selected units.



1.4.6 The Tool Box

The Tool Box is a floating box of buttons that can be used to facilitate certain actions of 
the main program.    The buttons in the box and the action they perform are:

Next - Advance to the next phase

Zoom - Toggle display between normal and zoom-in view

Cycle Stack - Cycle the units in the hot spot stack

Artillery - Display the Artillery Dialog

Units - Toggle the display of units on the map

Bases - Toggle the display of unit bases on the 3D map

Load/Unload - Load or unload selected units

Assault - Resolve the current assault

Display Indirect - Highlight indirect fire units

Display Spotted - Highlight spotted units

Display Moved - Highlight units that have moved

Display Fired/Fought - Highlight units that have fired or fought

Display Disrupted - Highlight units that are disrupted

Display Org - Highlight units in same organization as selected

Air Attack - Initiate air attack against current hex

Jump Window - Display the Jump Window

Next Stack - Jump to the next stack to be processed

A/I - Complete current phase under A/I

Command hints for each tool box button are displayed in the status bar at the bottom of 
the main window when the button is pressed.    Leaving the button without releasing 

clears the command hint.



1.4.7 Auto Scrolling

Auto Scrolling can be used to scroll the map display without having to use the scroll 
bars.    To cause the map to auto scroll, click the left mouse button in the map area and 
while holding the mouse button down, drag the mouse outside the boundaries of the 
map display.    This will cause the map display to automatically scroll in the direction of 
the mouse cursor.    Releasing the mouse button or bringing the mouse cursor back into 
the map display stops the scrolling.




